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1. Network connection and power activation of the camera
The WAT-933&WAT-2400S (simply called the “camera” from now on if there is no difference

in the function “WAT-933” and “WAT-2400S".) have two power supply systems. The one is
powered by +12VDC input plug on rear panel of the camera, and the other is powered by
the PoE using a LAN connector. When supplying power with DC + 12 V, use an independent

power supply for each camera, and do not share power with other cameras and devices.

Please supply power by either the one or the other of the way above and do not supply the

both power systems simultaneously.

The below figure is a connection example of the power supply by the PoE hub. In addition,

you need to have the power individually to the router and the PoE hub.

LAN cable
Router

PC

LAN cable

LAN cable

WAT-933 PoE hub
Figure 1. Network configuration example

Connect the LAN cable of camera side to the PoE port of the PoE hub and connect the LAN

cable of the router side to a normal LAN port.

If you want to supply power to the camera using the AC power supplies, connect the camera
and the router directly with exception of the PoE hub from the above. In a closed network
configuration, the DHCP protocol and the router are not required. In that case, connect the

PC and the camera directly in LAN cable.

It takes about 5 seconds to fully boot this camera from the power supply start.



2. Connection of external MIC. IN

This camera has the MIC. IN function.

You can use the internal MIC. IN attached to the camera, and the external MIC. IN.
Refer to "6.4.1.Video" for switching the internal MIC. IN and external MIC. IN.

The connection of external MIC. IN is explained below.

2.1. Corresponding terminal of external MIC. IN
When using the external MIC. IN, please use the electret condenser microphone of TRS, TS

terminal or line input of RCA terminal.

Figure 2. Corresponding terminal of external MIC. IN.



2.2. External MIC. IN connection example
Below is an example of connection of the input terminal.

Figure 3. Correct connection example

If you connect as shown below, it will cause an accident, so please do not do it absolutely.

Figure 4. Wrong connection example



3. Connection of 4P cable
The wiring diagram of the included 4P cable for power supply / microphone input is as shown in

the following figure.

Figure 5. Wiring diagram of 4P cable

Note: Please note that contact of each terminal and exterior case may cause malfunction.

(The negative terminal has a different potential from the power supply GND terminal.)



4. Network settings
Before using the camera, you need to configure the network.

The network initial settings and the camera setting examples are described below.

4.1. This camera network default settings
The network default setting of this camera is as follows.

Table 1. Default settings of network

IP Address 192.168.1.250 (static)
Netmask 255.255.255.0
Gateway 192.168.1.1

The network settings of this camera can be changed by the Web browser which will be
described later.

It is necessary to change the network setting of the PC and the camera according to the
situation.

For details on changing the network settings of the camera, refer to "4.5.1.Ethernet” below.

It is possible that the setting has been changed by this camera you used once.

In that case, please contact this camera administrator.

If you do not know the IP address you set, you can reset it to factory default settings.
Refer to "4.7. Initialization method of this camera" below.



4.2. Example of PC network settings
Connect this camera and your PC as shown in the below figure. And if the network setting of
the camera is in default configuration (IP Address: 192.168.1.250 (static)), go through the
following steps to set up the PC network settings.

PC
LAN cable

LAN cable

WAT-933 PoE hub

Figure 6. Minimum network configuration

Input the values as follow, click “OK” and close the property.

Internet Protocol Yersion 4 (TCP/IPvd) Properties @
General

You can get IP settings assigned automatically if vour network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings,

) obtain an IP address automnatically

ge the Fallowing IP address:

IP address: 192 168 . 1 100

Subnet mask: 255 255 255 . 0

Diefaulk gateway: |

Cbtain DMS server address aukomatically
@) Use the Following DMS server addresses:

Preferred DS server:

Alternate DMS server;

[T validate settings upon exit Advanced. .

[ 0K ] | Cancel |

Figure 7. Internet protocol version 4 property window
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5. Checking the image from the camera
You can check the video image after the network settings are completed.

This camera has the streaming format shown below.

Table 2. Streaming format

Name Encode Default resolution
H.264 Main H.264 1920 * 1080
H.264 Sub 640 * 360

JPEG MJPEG 1920 * 1080

Changes such as resolution and frame rate will be described later.

This section describes the method in the case of viewing the image from this camera using
the VLC media player.

A case of VLC media player
Download the appropriate VLC which meets your PC from VideoLAN official download page

(https://www.videolan.org/vic/index.html) and install.

Open the VLC media player when the installation is complete.

Click on Media <Open Network Stream from the menu.

11


https://www.videolan.org/vlc/index.html

Figure 8. Setting to display video streaming with VLC (No.1)

Paste your copied URL in the ‘Network Protocol’ box and click “Play”. Wait till the video start

streaming in your VLC.

H.264 (main). _rtsp://"This camera IP Address”/h264
H.264 sun):  rtsp://” This camera IP Address”/hsub
MJPEG: rtsp:// ” This camera IP Address’/jpeg
(Example: rtsp://192.168.1.250/h264)
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rtsp//192.168.1.250:554/h 264

Figure 9. Setting to display video streaming with VLC (No.2)

Video starts to stream when the network connections and settings work property.

Please check again the network settings if it does not start.

Figure 10. Streaming with VLC

The screen might become grey during the viewing, in that case, click the stop button in the

lower left and click the play button again.
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6. Changing the camera settings from the Web browser
On this camera you can change the configuration from the web browser.
The browser you use must correspond to html 5.

The recommended browser is Internet Explorer 11.

6.1. How to access the configuration page
Here's how to access the configuration page with a web browser.

Start the web browser and enter the following address.

http://"This camera IP Address”/
(Example: http://192.168.1.250/)

At the first time connection, the authentication window will open such as shown below.

The server 192.168.1.250 is asking for your user name and
password. The server reports that it is from admin.

Warning: Your user name and password will be sent using
basic authentication on a connection that isn’t secure.

Figure 11. IE window for authentication

User name: root
Password: 1234

Enter the above and click “OK”.
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The user name and password can be changed on the “4.2.1.User Information” described
later.

Note: If the page does not switch even if you input authentication information, check the
input characters. If the authentication window does not appear, restart the web

browser.

6.1.1. WAT-933 System Configuration: Overview (top page)

Open your web browser and go to the following address page.

This page displays the overview. This page is the top page.

Note:SD CARD SETUP of the menu is displayed only when microSD card is inserted. If it is

not displayed even though it is already inserted, please refresh the browser (F5).

Figure 12. The Overview page (Top page)

The IP Address, MAC Address, Host Name, SD Card Size and Firmware Version of this
camera are displayed. The SD Card Size is displayed only when the microSD card is

inserted.
The setting menu of this camera is displayed on the left side of the page.

By clicking the link, you can display each setting page.

Each setting pages are explained below.

15



6.2. SYSTEM SETUP
6.2.1. User Information
Click “User” on menu to go to the User Information page.

Here you can set the ID and password used in each connection.

SYSTEM SETUP

User Information submit
Date & Time
D
Update
Savelload Selings Password [ooes ]
Reset Confim ]

IMAGE SETUP
IRIS
Exposure
Backlight
Picture
Motion
Qutput Set

System

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethernet

Figure 13. The User Information page

ID
Set the ID to be used for each connection.

The default setting is "root".

Password, Confirm

Set the Password to be used for each connection.

Type your password once more in the Confirm Password box to ensure that it is correct.
If Confirm and Password do not match, the password will not be changed.

The default setting is “1234”.

To update the setting value, please click “submit”.

Please attention that the authentication window will be displayed again when you change ID
or Password.

The ID and Password set here are commonly used for WEB setting page, ONVIF and FTP.
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6.2.2. Date & Time
Click “Date & Time” on menu to go to the Date & Time page.

Here you can set the time to use in this camera.

SYSTEM SETUP

Date & Time submit
User
Date & Time R R
SNTP Enable ® OFF C ON
Update
SNTP Server time.goegle.com
Save/Load Settings
Frar Repetition Period 3600 [=1](sec)
Retry Time 10 [=1](sec) - If SNTP fails, retry(ex: 2 times, every 10 seconds).
IMAGE SETUP
Retry Count 5 [=0]
IRIS
Exposure
BacKlight Time 2018]-[10]- [51]: et FC time
Picture
Motion .
Summer Time * OFF ON
Qutput Set .
Timezone (UTC+09:00) Seoul, Tokyo hd
System
Camera Time 2018-10-01 11:51:47
VIDEO SETUP PC Time 2018-10-02 11:53:16
VLD UpTime ODays 02:13:49

H.264 View
JPEG View

NETWORK SETUP
Ethernet

Figure 14. The Date & Time page

SNTP Enable

Use an external SNTP server to switch ON / OFF setting for time acquisition.

When this setting is ON, you can connect to the external SNTP server and synchronize
time.

The default setting is “OFF”.

SNTP Server

It is enabled when SNTP Enable is ON.

Enter the IP address or server name of the external SNTP server.
The default setting is “time.google.com”.

Repetition Period

It is enabled when SNTP Enable is ON.

Set the Repetition Period for synchronization with the SNTP server.
The default setting is “3600”.
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Retry Time

It is enabled when SNTP Enable is ON.

Set the retry time when connect to the SNTP server fails.
The default setting is “10”.

Retry Count
It is enabled when SNTP Enable is ON.
Set the count of retries when connect to SNTP server fails.

The default setting is “2”.

Time
Set the time of this camera.
You can match the client PC time with Get PC time.

Summer Time

It is enabled when SNTP Enable is OFF.
Switch ON / OFF used of summer time.
The default setting is OFF.

Timezone
It is enabled when SNTP Enable is OFF.
Select the time zone.

The default setting is “(UTC+09:00) Seoul, Tokyo”.

Camera Time

The time of the camera is displayed.

PC Time
The time of the client PC is displayed.

UpTime

Displays the elapsed time since startup.

To update the setting value, please click the “submit” button.

18



6.2.3. Firmware Update
Click “Update” on menu to go to the Firmware Update page.

Here you can update the camera firmware.

SYSTEM SETUP )
Firmware Update submit
User

Date & Time .

Version Info 1.01
Update

Save/Load Settings

Reset Firmware Path Browse...

IMAGE SETUP
IRIS

Exposure

Backlight

Picture
Motion
Output Set

System

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethemnet

Figure 15. The Firmware Update page

Version Info
Displays the current firmware version.

Firmware Path
Select the firmware file that exists on the client PC.

To update the firmware, select Firmware Path, and click “submit”.

When the firmware is correctly transmitted, a progress bar will be displayed.

When the progress bar reaches 100%, the reboot confirmation message will be displayed,
so select OK.

Please attention that the authentication window will be displayed again when ID or
Password has been changed on the “4.2.1.User Information”.
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6.2.4. Save/Load Settings

Click “Save/Load Settings” on menu to go to the Save/Load Settings page.

Here you can save and load the camera setting values.

Example: As shown in Figure 12, you can load the configuration file saved from an

individual with the same individual or load it with another individual.

The camera A The camera B
Load

Save Load

File

Figure 16. Example of using Save / Load Settings

SYSTEM SETUP

Save/Load Settings submit
User
Date & Time
Save Settings to File Save
Update
Save/Load Settings
Reset Load Settings from File Browse...

IMAGE SETUP
IRIS
Exposure
Backlight
Picture
Motion
Output Set

System

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethernet

Figure 17. The Save/Load Settings page
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Save Settings

Output the settings of this camera to a file and save it on the client PC.

The settings that can be saved are all settings that can be changed on the WEB setting
page.

Click “Save” to save the configuration file (WAT-933_Setting.set or
WAT-2400S_Setting.set) on the client PC.

Load Settings

Upload the file that output the settings of this camera from the client PC and load it.
Select the setting file (WAT-933_Setting.set or WAT-2400S_Setting.set) saved on the
client PC.

To update the setting value, please click “submit”.

When loading of the setting file is completed, a confirmation message of restart will be
displayed. Please select “OK”.

Please attention that the authentication window will be displayed again when ID or

Password has been changed on the “4.2.1.User Information”.
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6.2.5. Reset
Click “Reset” on menu to go to the Reset page.

Here you can reset and reboot the camera.

SYSTEM SETUP
Reset
User
Date & Time
System Reset RESET
Update
Save/Load Settings
Image Reset RESET
IMAGE SETUP
RIS Reboot REBOCT

Exposure
Backlight
Picture
Motion
Output Set

System

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethemnet

Figure 18. The Reset page

System Reset

Reset the settings other than IMAGE SETUP to the default settings.

It will be executed as soon as you click it.

Please attention that the authentication window will be displayed again when ID or

Password has been changed on the User Information page.

Image Reset
Reset IMAGE SETUP to the default setting.
It will be executed as soon as you click it.

Reboot
Reboot the camera.

When you click on it, a reboot confirmation dialog will be displayed, select “OK” to reboot.
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6.3. IMAGE SETUP
6.3.1. IRIS
Click “IRIS” on menu to go to the IRIS page.

Here you can set the IRIS mode.

SYSTEM SETUP

User

IRIS submit

Date & Time
Mode
Update

Save/Load Settings

Reset

IMAGE SETUP

Exposure
Backlight
Picture
Motion
Output Set

System

VIDEO SETUP
Video

H.264 View
JPEG View

NETWORK SETUP
Ethernet

Figure 19. The IRIS page

Mode
Select from the following 2.
Table 3. Selectable items of Mode

1 ELC Electronic shutter control. Exposure control is performed with
shutter speed and AGC, and the IRIS lens is fully opened.

2 | ALC Auto iris control. Exposure control is performed with iris and
AGC, and the shutter speed is fixed.

The default setting is “ELC”.

To update the setting value, please click the “submit” button.
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6.3.2. Exposure
Click “Exposure” on menu to go to the EXPOSURE page.

Here you can set the exposure, brightness, gain, etc. of the sensor.

Figure 20. The EXPOSURE page
Brightness
Set the brightness of the image.
It can be set between 0 ~ 20.
The smaller the value, the darker it is, the larger it gets brighter.
The default setting is “10”.

ANTI-SAT

Turn ON/OFF the function improving the video saturation caused by light.
Set the degrees of improving the saturation of light areas.

The default setting is “OFF”.

WEIGHT

The higher the value, the darker the surrounding area gets when improving saturation of
light areas.

The default setting is “10”.
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LEVEL

Brightness settings for light areas recognition. If both light and surrounding areas are very

bright, the value of LEVEL should be set high for recognizing light areas.

Note: If the sky that is very bright at daytimes is saturated, the LEVEL should be set high
to recognize light areas and improve saturation.

The default setting is “10”.

STABILIZING

Set the control stabilization level for light areas video changes.
It can be selected from LOW / MIDDLE / HIGH / OFF.

The default setting is “HIGH”.

BACKLIGHT

Automatically corrects surrounding areas that is darkened by saturation improvement of
light areas through Digital Gamma.

It can be selected from LOW / MIDDLE / HIGH.

The default setting is “HIGH”.

AE SPEED

Set the AE control speed.

It affects speed of shutter speed and iris change.

It can be selected from LOW / MIDDLE / HIGH.

It becomes late when it is LOW, and it becomes faster when it is HIGH.
The default setting is “MIDDLE”.
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Shutter

Select from the following 3.

Table 4. Selectable items of Shutter

1 Auto When Mode of "4.3.1.IRIS" is ELC, shutter speed is
automatically controlled. For ALC, fix the shutter speed to 1/30
or 1/25.

2 | Manual Set the shutter speed to an arbitrary fixed value.
(See Table 7)

3 | Flicker Fix the shutter speed at 1/100 or 1/120, reducing the flicker
phenomenon.

The default setting is “Auto”.

Mode

It is enabled when Shutter is “Auto”.

This items that can be selected differ depending on the Mode setting on the "4.3.1. IRIS".
When Mode of the "4.3.1.IRIS" is ELC, select from the following two.

Table 5. Selectable items of Mode (When IRIS Mode is ELC)

1 Normal

Normal mode.

2 Deblur

Adjusting the shutter speed and AGC will reduce motion blur.

When Mode of "4.3.1.IRIS" is ALC, select from the following two.

Table 6. Selectable items of Mode (When IRIS Mode is ALC)

1 Indoor Exposure control is performed by normal IRIS control.

2 | Outdoor Adjust the shutter speed so as not to excessively narrow the
IRIS in a strong light environment.

3 | Deblur Adjusting the shutter speed and AGC will reduce motion blur.

The default setting is “Normal”.
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Speed

It is enabled when Shutter is Manual.

The select items will change according to the Frequency of the "4.3.7. OUTPUT SET"
which will be described later.

List items that can be selected below.

Table 7. Selectable items of Speed

When Frequency is 60Hz When Frequency is 50Hz
1/30 1/25
1/60 1/50
1/120 1/100
1/250 1/200
1/500 1/400

1/1000 1/800

1/2000 1/1600
1/4000 1/3200
1/8000 1/6400
1/15000 1/12800
1/30000 1/25600

The default setting is “1/30” or “1/25”.

Slow Shutter

It is disable when shutter is Manual.

It is also disable when Mode of the Output Set page which will be described later is 15 fps
WDR or 12 fps WDR.

The slow shutter increases the sensitivity.

It can be selected from OFF / x2 / x4 / x8 / x16 / x32.

The default setting is “OFF”.
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AGC MAX

Set the maximum gain.

It can be set between 0 ~ 72 dB.
The default setting is “72”.

AGC MIN

Set the minimum gain.

It can be set between 0 ~ 72 dB.

Note: Setting a value higher than the AGC MAX will automatically have the same value
as the AGC MAX.

The default setting is “0”.

Note: Relationship between AGC and Slow Shutter
When both AGC and Slow Shutter are working, exposure control by AGC takes
precedence. Therefore, as shown in the figure, Slow Shutter may not work if it
converges to the target brightness only with AGC.

Target brightness

AGC: 0 AGC: 30 AGC: 72
Slow Shutter: x32 Slow Shutter: x32 Slow Shutter: x32

Figure 21. Relationship between AGC and Slow Shutter

To update the setting value, please click the “submit” button.
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6.3.3. Backlight
Click “Backlight” on menu to go to the BACKLIGHT page.

Here you can set the backlight and highlight compensation.

Figure 22. The BACKLIGHT page

Mode
It is disable when Mode of the “4.3.7.0Output Set” which will be described later is 15 fps
WDR or 12 fps WDR.
Select from the following 3.
Table 8. Selectable items of Mode

1 OFF Backlight compensation is not used.

2 | HLC Highlight compensation is used.
Highlight compensation is aimed at reducing the burden on the
observer by improving the visibility by applying mask

processing to intense light.

3 | BLC Backlight compensation is used.

Backlight compensation is to increase the brightness of the
entire image and make the subject that is blackened by
backlighting to the appropriate brightness.

The default setting is “OFF”.
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HLC - Level

It is enabled when Mode is “HLC”.

Set the mask brightness level.

It can be set between 0 ~ 20.

The smaller the value, the lower the brightness threshold of the mask, and the larger the
value, the higher the brightness threshold of the mask.

The default setting is “10”.

HLC - Color

It is enabled when Mode is “HLC”.

Set the mask color.

You can select from WHT / YEL/ CYN / GRN / MAG / RED / BLU / BLK.
The default setting is “BLK”.

BLC — BLC OSD ON

It is enabled when Mode is “BLC”.

Set visibility of backlight compensation area.
The default setting is “OFF”.

BLC - H position

It is enabled when Mode is “BLC".

Set the horizontal start position of the backlight compensation area.

It can be set between 0 ~ 20.

The smaller the value, to the left moves, and the larger the value, to the right moves.

The default setting is “8”.

BLC -V position

It is enabled when Mode is “BLC".

Set the vertical start position of the backlight compensation area.

It can be set between 0 ~ 20.

The smaller the value, to the up moves, and the larger the value, to the down moves.

The default setting is “7”.
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BLC - H size

It is enabled when Mode is “BLC".

Set the horizontal size of the backlight compensation area.

It can be set between 0 ~ 20.

The smaller the value, to the left moves, and the larger the value, to the right moves.

The default setting is “3”.

BLC -V size

It is enabled when Mode is “BLC".

Set the vertical size of the backlight compensation area.

It can be set between 0 ~ 20.

The smaller the value, to the up moves, and the larger the value, to the down moves.

The default setting is “3”.

To update the setting value, please click “submit”.

31



6.3.4. Color

Click “Color” on menu to go to the COLOR page.
Here you can set such as the auto white balance.
This page is only WAT-2400S

SYSTEM SETUP

COLOR submit
User
Date & Time
AWB AUTO v
Update
Calor Gain [0~40]
Save/lLoad Settings
Reset
Preset
IMAGE SETUP
Preset ® Idle SET
IRIS
Exposure
Backlight Manual
C Temp 5000K v
Picture R Gain 10 [0~20]
Motion B Gain 10 [0~20]

Quitput Set

System

VIDEC SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethernet

SD CARD SETUP

Info

Figure 23. The COLOR page

AWB
Set the auto white balance.
Select from the following four.
Table 9. Selectable items of AWB

1 AUTO Automatically performs white balance control.

2 | AUTOext White balance control is automatically performed at a color
temperature range wider than AUTO.

3 | PRESET The white balance can be automatically corrected according to
the environment, and the compensation value can be fixed.

Please see Preset below for details.

4 MANUAL You can select from a predetermined color temperature.

The default setting is “AUTO”.
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Color Gain

Set the color gain.

It can be set between 0~40.

The smaller the value, the lower the saturation, and the larger the value, the higher the
saturation.

The default setting is “25”.

Preset

It is enabled when AWB is “PRESET".

Set the preset white balance.

You can be select from Idle / SET.

When this item is set to SET, the white balance is automatically adjusted according to the
usage environment.

When this item is set to idle, the adjusted white balance is fixed.

The default setting is “Idle”.

C Temp

It is enabled when AWB is “MANUAL".

Set the color temperature.

You can be select from 3000K / 5000K / 8000K.
The default setting is “5000K”.

R Gain

It is enabled when AWB is “MANUAL".

Set the red gain.

It can be set between 0~20.

The smaller the value, the negative compensation is applied to the R component.
The larger the value, the positive compensation is applied to the R component.
The default setting is “10”.
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B Gain

It is enabled when AWB is “MANUAL".

Set the blue gain.

It can be set between 0~20.

The smaller the value, the negative compensation is applied to the B component.
The larger the value, the positive compensation is applied to the B component.
The default setting is “10”.

34



6.3.5. Picture
Click “Picture” on menu to go to the PICTURE page.

Here you can set such as the sharpness, contrast of the image.

Figure 24. The PICTURE page
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Sharpness

Set the sharpness.

It can be set between 0 and 10.

The smaller the value, the lower the sharpness, and the larger the value, the higher the
sharpness.

The default setting is “5”.

Gamma

Set the gamma correction.

It can be selected from 0.45/0.55/0.65/0.75.
The default setting is “0.55”.

Mirror
Switch ON / OFF of left / right reversal.
The default setting is “OFF*.

Flip
Switch ON / OFF of upside-down.
The default setting is “OFF*.

ACE

Set the contrast.

It can be selected from OFF / LOW / MIDDLE / HIGH.
The default setting is “OFF*.

Defog

Switch ON / OFF use of defog correction.

Defog correction improves visibility deteriorated by fog, snow, dust etc.
The default setting is “OFF*.

Defog - Mode

It is enabled when Defog is “ON*.

It can be selected from MANUAL / AUTO.

When this item is MANUAL, fog correction is always performed.

When this item is AUTO, fog correction is automatically performed as necessary.
The default setting is “AUTO”.
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Defog - Level

It is enabled when Defog is “ON*.

It can be selected from LOW / MIDDLE / HIGH.
The default setting is “MIDDLE”.

Privacy
Switch ON / OFF use of privacy mask.
The default setting is “OFF*.

Mask mode

It is enabled when Privacy is “ON*.

It can be selected from FILL / FORMAT.

When this item is FILL, fill the mask area.

When this item is FORMAT, make the mask area black and white reversed.
The default setting is “FILL".

Y level

It is enabled when Privacy is “ON*.

Set the brightness of the mask color.

It can be set between 0 ~ 20.

The smaller the value, the lower the brightness, and the larger the value, the higher the
brightness.

The default setting is “10”.

CB level

It is enabled when Privacy is “ON*.

Set the intensity of the B component of the mask color.

It can be set between 0 ~ 20.

The smaller the value, the lower the intensity of B component, the larger value, the higher
the intensity of B component.

The default setting is “10”.
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CR level

It is enabled when Privacy is “ON*.

Set the intensity of the R component of the mask color.

It can be set between 0 ~ 20.

The smaller the value, the lower the intensity of R component, the larger value, the higher
the intensity of R component.

The default setting is “10“.

Trans

It is enabled when Privacy is “ON*.

Set the transparency of the mask.

It can be set between 0 ~ 3.

The smaller the value, the lower the transparency, the larger the value, the higher the
transparency.

The default setting is “0”.

Privacy Zone
It is enabled when Privacy is “ON*.
Atotal of 15 masks can be set.
The setting items of each mask are explained below.
A) Zone Disp
Switch display ON / OFF of each mask.
B) H-POS
Sets the horizontal start position of each mask.
C) V-POS
Sets the vertical start position of each mask.
D) H-SIZE
Sets the horizontal size of each mask.
E) V-SIZE
Sets the vertical size of each mask.
F) submit

Updates the setting of each mask.
To update the setting value, please click “submit”.

Please attention that you need to click “submit” next to each mask setting when updating the

setting of each mask.

38



6.3.6. Motion
Click “Motion” on menu to go to the MOTION page.

Here you can set motion detection.

SYSTEM SETUP

MOTION ot
User
Date & Time i )
MOTION ® OFF O ON
Update
Save/Load Settings
Reset DETECTION TONE 2 [0~4]
MDRECT FILL OFF ® ON
IMAGE SETUP
RIS SENSITIVITY 5 [0~10]
Exposure MOTION OSD OFF ® ON
Backlight TEXT ALARM OFF ® ON

Picture
Motion

Qutput Set

Motion Zone

Zone Disp  H-POS V-POS H-SIZE V-SIZE Submit

System [0~60] [0~34] [0~60] [0~34]

VIDEO SETUP

Vid 0 OFF 1 1 58 32 submit
ideo s ON
H.264 View
JPEG View 1 ® OFF 10 11 20 11 submit
ON
NETWORK SETUP 2 ® OFF 30 22 20 11 submit
Ethernet ON
3 ® OFF 50 33 20 11 submit
ON

Figure 25. The MOTION page

MOTION
Switch ON / OFF use of the motion detection.
The default setting is “OFF*.

DETECTION TONE
It is enabled when MOTION is “ON*.
Set the display method of effective area of motion detection.
It can be set between 0 ~ 4.
Table 10. Selectable items of DETECTION TONE
0 | The detection range is displayed with a white frame.

1 The detection range is displayed with the transparent frame.

2 | The detection range is displayed as a transparent frame with

higher transparency than 1.

3 | The detection range is not displayed.

4 | The detection range is displayed with the thin green frame.

The default setting is “2”.
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MDRECT FILL

It is enabled when MOTION is “ON*.

Switch the ON / OFF of the fill of the motion detection area.
The default setting is “ON”.

SENSITIVITY

It is enabled when MOTION is “ON*.

Set the sensitivity of motion detection.

It can be set between 0 ~ 10.

The smaller the value, the lower the sensitivity, and the larger the value, the higher the
sensitivity.

The default setting is “5”.

MOTION OSD

It is enabled when MOTION is “ON*.

Switch ON / OFF of OSD display at motion detection.
The default setting is “ON”.

TEXT ALARM

It is enabled when MOTION is “ON*.

Switch ON / OFF of the text display of motion detection.
The default setting is “ON”.
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Motion Zone

It is enabled when MOTION is “ON*.

Sets the motion detection zone.

Atotal of 4 motion detection zones can be set.

The setting items of each zone are explained below.

A) Zone Disp

Switch ON / OFF enable of each zone.
B) H-POS

Sets the horizontal start position of each zone.
C) V-POS

Sets the vertical start position of each zone.
D) H-SIZE

Sets the horizontal size of each zone.
E) V-SIZE

Sets the vertical size of each zone.
F) submit

Update the setting of each zone.
To update the setting value, please click “submit”.

Please attention that you need to click “submit” next to each zone setting when updating the

setting of each zone.
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6.3.7. Output Set
Click “Output” Set on menu to go to the OUTPUT SET page.
Here you can set Sensor output.

SYSTEM SETUP

QUTPUT SET submit
User
Date & Time
Mode 30fps Normal v
Update
Save/Load Settings
Reset Level HIGH v
Frequency © 50Hz ® 60Hz

IMAGE SETUP
IRIS
Exposure
Backlight
Picture
Motion
Output Set

System

VIDEO SETUP
Video
H.264 View

JPEG View

NETWORK SETUP
Ethernet

Figure 26. The OUTPUT SET page
Mode
The settings that can be selected will change depending on the Frequency setting
described below.
When Frequency is 60Hz, select from the following 3.

Table 11. Selectable items of Mode (When Frequency is 60Hz)

1 30fps Normal Takes with 30fps Normal.

2 15fps WDR Takes with 15fps wide dynamic range.

The wide dynamic range is a setting that combines two
frames with different exposure times and expands the
dynamic range.

3 | 30fps DNR Takes with 30fps dynamic noise reduction.

When Frequency is 50Hz, select from the following 3.

Table 12. Selectable items of Mode (When Frequency is 50Hz)

1 25fps Normal Takes with 25fps Normal.
12fps WDR Takes with 12fps wide dynamic range.
25fps DNR Takes with 25fps dynamic noise reduction.

The default setting is “30fps Normal” or “25fps Normal”.
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Level

It is enabled when Mode is 15fps WDR / 30fps DNR / 12fps WDR / 25fps DNR.
It can be selected from LOW / MIDDLE / HIGH.

The default setting is “HIGH”.

Frequency
It can be selected from 50Hz / 60Hz.

The default setting is “60Hz".

To update the setting value, please click “submit”.
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6.3.8. System
Click “System” on menu to go to the SYSTEM page.

Here you can set Color bar and Title.

SYSTEM SETUP

SYSTEM submit
User
Date & Time . .
Color bar ® OFF C ON
Update
Save/lLoad Settings
Cam Title OFF v

Reset

IMAGE SETUP 00000000

IRIS
Exposure
Backlight
Picture
Motion
Qutput Set
System

VIDEO SETUP
Video

H.264 View
JPEG View

NETWORK SETUP
Ethemet

Figure 27. The SYSTEM page

Color bar
Switch ON / OFF of the Color bar.
The default setting is “OFF”.

Cam Title
You can set the title to be displayed to the image.

It can be selected from OFF / Right up / Left down.
The title is allowed 8 alphanumeric characters.

To update the setting value, please click “submit”.
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6.4. VIDEO SETUP
6.4.1. Video
Click “Video” on menu to go to the Video Information page.

Here you can set streaming etc.

Figure 28. The Video Information page

Max Resolution

It display the maximum size that can be streamed.

Max FPS

It display the maximum framerate that can be streamed.
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Output Mode
Display the current sensor output mode.

RTSP Port
Configure the port of the RTSP protocol.
The default setting is “554”.

Select Recording

Select recorded streaming of microSD card.

It can be selected from H.264 MAIN / H.264 SUB.
The default setting is “H.264 MAIN”.

Timestamp Display
Switch ON / OFF of the Timestamp.
The default setting is “ON”.

Mix Audio with Streaming & Recoding
Switch audio input ON / OFF.
The default setting is “ON”.

Select Audio
Select the audio input mode from the following 3.

Table 13. Selectable items of Select Audio

1 INTERNAL MICROPHONE

Use the included microphone.

2 | EXTERNAL AUDIO

Use external input.

MIX BOTH

Use both.

The default setting is “INTERNAL MICROPHONE”.

H.264 Main
H.264 Profiles

H.264 Main Select compression profile for streaming.
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It can be selected from Baseline / Main.

For the same bit rate, the Main Profile tends to have higher image quality.
However, please note that some playback devices may not support Main Profile.
The default setting is “Baseline”.

H.264 Resolution
H.264 Main Selects the resolution size of the streaming.
Table 14. Selectable items of H.264 Resolution
H.264 Resolution
1920x1080
1280x720
800x600
704x480
704x400
640x480
640x360
320x240
The default setting is “1920x1080”.

H.264 Quality

It is enable when the Bitrate Control described later is "VBR".

Set compression quality.

It can be set between 10 ~ 51.

The smaller the value, the higher the quality, and the larger the value, the lower the
quality.

The default setting is “50”.

H.264 GOP (IDR)

H.264 Main Set compression GOP for streaming.

It can be set between 1 ~ 150.

The smaller the value, the lower the compression rate, but the faster the seek time.
The larger the value, the higher the compression rate, but the seek time will be slower.
The default setting is “30”.

H.264 FPS

H.264 Main Set framerate for streaming.

47



Depending on the Frequency setting on the “4.3.7.0utput Set”, the items that can be
selected will change.

List items that can be selected below.

Table 15. Selectable items of H.264 FPS

When Frequency is 60Hz When Frequency is 50Hz
30fps 25fps
15fps Sfps
10fps 1fps
6fps -

5fps -

3fps -

2fps -

1fps -

The default setting is “30fps” or “25fps”.

Bitrate Control

H.264 Main Select compression method for streaming from the following 2 methods.
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Table 16. Selectable items of Bitrate Control

1 | VBR

Variable Bitrate.

Quality is constant, and bitrate is variable.

Since the bit rate changes according to the subject, network
bandwidth can be used efficiently.

However, since the bandwidth used is not constant, it is difficult

to design the network.

2 |CBR

Constant Bitrate.

Bitrate is constant, and quality is variable.

Because the bandwidth used is constant, network design is
easy.

However, depending on the subject, the bandwidth may be

wasted, or the image quality may be poor.

3 | CVBR

Constant Variable Bitrate.

In H.264, the data size is reduced by putting the difference data
(P-frame) between the complete image data (I-frame).

In CBR mode, to keep the constant bandwidth, the quality of
next |-frame is degraded, when size of P-frame is increase.
During this period, the quality will be extremely reduced.

In CVBR mode, keep the next I-frame quality, even if the size of
P-frame is increase. As a result, the bit rate increases, but the

image quality improves.

The default setting is “CBR”.
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H.264 Bitrate
H.264 Main Select the upper limit Bitrate of streaming from the following.
Table 17. Selectable items of H.264 Bitrate
H.264 Bitrate
20 Mbit
19 Mbit
18 Mbit
17 Mbit
16 Mbit
15 Mbit
14 Mbit
13 Mbit
12 Mbit
11 Mbit
10 Mbit
9 Mbit
8 Mbit
7 Mbit
6 Mbit
5 Mbit
4 Mbit
3 Mbit
2 Mbit
1 Mbit
512 Kbit
256 Kbit
128 Kbit

The higher the setting, the higher the quality, but the larger the data size is.
The default setting is “10Mbit”.
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H.264 Sub

H.264 Sub Profiles

H.264 Sub Select compression profile for streaming.
Details are the same as H.264 Profiles of H.264 Main.

The default setting is “Baseline”.

H.264 Sub Resolution
H.264 Sub Selects the resolution size of the streaming.

Table 18. Selectable items of H.264 Sub Resolution
H.264 Sub Resolution
640x360
320x240
The default setting is “640x360”.

H.264 Sub Quality

It is enable when the Bitrate Control described later is "VBR".
Details are the same as H.264 Quality of H.264 Main.

The default setting is “50”.

H.264 Sub GOP (IDR)

H.264 Sub Set compression GOP for streaming.
Details are the same as H.264 GOP of H.264 Main.
The default setting is “30”.

H.264 Sub FPS

H.264 Sub Set framerate for streaming.

Details are the same as H.264 FPS of H.264 Main.
The default setting is “30fps” or “25fps”.

Bitrate Control

H.264 Sub Select compression method for streaming.
Details are the same as Bitrate Control of H.264 Main.
The default setting is “CBR”.
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H.264 Sub Bitrate

H.264 Sub Select the upper limit Bitrate of streaming.
Details are the same as H.264 Bitrate of H.264 Main.
The default setting is “2Mbit”.

MJPEG
M-JPEG Resolution
The resolution size of MUPEG streaming is fixed "1920 x 1080".

M-JPEG Quality

It is enable when the Bitrate Control described later is "VBR".

Set compression quality.

It can be set between 0 ~ 99.

The smaller the value, the lower the quality, and the larger the value, the higher the
quality.

The default setting is “50”.

M-JPEG FPS

MJPEG Set framerate for streaming.

Details are the same as H.264 FPS of H.264 Main.
The default setting is “30fps” or “25fps”.

Bitrate Control
MJPEG Select the compression quality specification method for streaming from the
following 2 method.

Table 19. Selectable items of Bitrate Control

1 VBR Variable Bitrate.

Quality is constant, and bitrate is variable.
2 | CBR Constant Bitrate.

Bitrate is constant, and quality is variable.

The default setting is “CBR”.
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M-JPEG Bitrate
MJPEG Select the upper limit Bitrate of streaming from the following.

Table 20. Selectable items of M-JPEG Bitrate
MJPG Bitrate
50 Mbit
45 Mbit
40 Mbit
35 Mbit
30 Mbit
25 Mbit
20 Mbit
19 Mbit
18 Mbit
17 Mbit
16 Mbit
15 Mbit
14 Mbit
13 Mbit
12 Mbit
11 Mbit
10 Mbit
9 Mbit
8 Mbit
7 Mbit
6 Mbit
5 Mbit
4 Mbit
3 Mbit
2 Mbit
1 Mbit

The higher the setting, the higher the quality, but the larger the data size is.
The default setting is “20Mbit”.

To update the setting value, please click “submit”.
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6.4.2. H.264 View

Click “H.264 View” on menu to go to the view page.
Here you can watch streaming of H.264 Main.
Streaming can be confirmed only with IE.

The first display is 1920 x 1080 size.

Figure 29. The H.264 view page

Back
Return the page to the previous page.

It is the same movement as the browser's back button.
Play
Start streaming.

If it has already started, pause it.

Stop
Stop streaming.
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1920x1080
Change the streaming playback area to 1920 x 1080.

1280x720
Change the streaming playback area to 1280x720.

800x600
Change the streaming playback area to 800x600.

640x480
Change the streaming playback area to 640x480.

320x240
Change the streaming playback area to 320x240.
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6.4.3. JPEG View

Click “JPEG View” on menu to go to the view page.

Here you can watch image of JPEG.

JPEG images are updated approximately every 3 seconds.
The image size will be fixed at 1920 x 1080.

Figure 30. The JPEG view page
Back

Return the page to the previous page.

It is the same movement as the browser's back button.
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6.5. NETWORK SETUP
6.5.1. Ethernet
Click “Ethernet” on menu to go to the Network Information page.

Here you can set network etc.

SYSTEM SETUP

Network Information submit
User
Date & Time
IP Address 192.168.1.250
Update
Savelload Settings Subnet Mask 255.255.255.0
Reset Default Gateway 192.168.1.1
Primary DNS Server 8.8.8.8
IMAGE SETUP
Secondary DNS Server 8844
IRIS
Exposure Use DHCP Server O USE ® UNUSE
Backlight
Picture FTP Server O ON ® OFF

Motion
Output Set

System

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethernet

SD CARD SETUP

Info

Figure 31. The Network Information page

IP Address
It is enable when the Use DHCP Server described later is “UNUSE”.

Set the IP address.
The default setting is “192.168.1.250".

Subnet Mask
It is enable when the Use DHCP Server described later is “UNUSE”.

Set the sub-net mask.
The default setting is “255.255.255. 0”.

Default Gateway
It is enable when the Use DHCP Server described later is “UNUSE”.

Set the default gateway.
The default setting is “192.168.1.1".
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Primary DNS Server

It is enable when the Use DHCP Server described later is “UNUSE”.
Configure the primary DNS server.

The default setting is “8.8.8.8”.

Secondary DNS Server

It is enable when the Use DHCP Server described later is “UNUSE”.
Configure the secondary DNS server.

The default setting is “8.8.4.4”.

Use DHCP Server

Switch ON / OFF use of DHCP server.

When this setting is ON, this camera will receive the IP address from the external DHCP
server.

The default setting is “OFF”.

FTP Server
Switch ON / OFF FTP server function.
The default setting is “OFF”.

For details on how to connect the FTP server, refer to "5.2. FTP Access" below.

To update the setting value, please click “submit”.
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6.6. SD CARD SETUP
6.6.1. Info
Click “Info” on menu to go to the SD Card Information page.

Here you can make settings related to the microSD card.

SYSTEM SETUP
User

Date & Time

SD Card Information

Total Size 6109SMB
Update

Used Size 131MB
Save/Load Settings

Free Size 60967MB
Reset

Free Percentage 99%

IMAGE SETUP . ) . A

Continuous Recording ® ON O QOFF
IRIS
Exposure
Backlight Save Jpeg in SD-Card submit
Picture
Motion Format Format
Qutput Set
System

Video & Snapshot Files Files

VIDEO SETUP
Video
H.264 View
JPEG View

NETWORK SETUP
Ethernet

SD CARD SETUP

Figure 32. The SD Card Information page

Total Size
Displays the total size of the microSD card.

Used Size
Displays the used size of the microSD card.

Free Size
Display the free size of the microSD card.

Free Percentage
Displays the Percentage of (Free size) / (total size).
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Continuous Recording
Switch ON / OFF recording to the microSD card.
The default setting is “ON”.

Save Jpeg in SD-Card
Save JPEG still images to the microSD card.

The still image is saved at the moment when you click the “submit” button.

Format

Format the microSD card.

When you click the “Format” button, the page switches and Format starts.
When Format ends, you are prompted to restart, click the “OK” button.

Please attention that saved data on the microSD card will be deleted.

Video & Snapshot Files

Download recorded video and still images saved to the microSD card.

In order to use this function, you need to set Continuous Recording to “OFF”.

When you click the “Files” button, you can check the file to the microSD card.

To update the setting value, please click “submit”.
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6.6.2. Schedule
Click “Schedule” on the menu to go to the Record Schedule page.

Here you can make settings related to the Record Schedule.

Figure 33. The Record Schedule page

Camera Time

Display the current time of the camera.

Schedule
A total of 4 schedules can be set.
The “Enable” is all OFF by default settings.

When the “Enable” is OFF, the current time is automatically set.
The setting items of each mask are explained below.

A) Enable
Switch Enable ON / OFF of the Schedule.
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F)

G)

YEAR

Set a year of schedule.

It can be set between 2000 ~ 2099.

MONTH

Set a month of schedule.

It can be set between 1 ~12.

DAY

Set a day of schedule.

It can be set between 1 ~ 31.

HOUR

Set an hour of schedule.

It can be set between 0 ~ 23.

MINUTE

Set a minute of schedule.

It can be set between 0 ~ 59.

ACTION

Decide the operation at the schedule execution.

It can be selected from Recording Start/ Recording Stop”.

The default setting is the “Recording Start”.

If the schedule execution time of the "Record start" arrives when the
recording is already in progress, it will not do anything.

REPEAT

Decide whether to repeat the schedule after schedule execution.
It can be selected from None/Hourly/Daily/Weekly.

The default setting is “None”.

After the schedule execution, when the setting is other than None, it

will be automatically updated to the next execution time.

To update the setting value, please click “submit”.
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6.6.3. Timelapse
Click “Timelapse” on the menu to go to the Timelapse page.
Here you can make settings related to the Timelapse.

Figure 34. The Timelapse page

Camera Time

Display the current time of the camera.

Timelapse Enable

Switch ON / OFF Timelapse function.

The default setting is “OFF”.

Image saving starts when it is set to ON, and image saving is performed each time the

Interval Time elapses.
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Interval Time

Set the image save interval.

It can be set between 10 ~ 604800 sec.
The default setting is “10”.

To update the setting value, please click “submit”.
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6.7. How to initialize the camera setting
You can use the microSD card to initialize the settings.

This initialization method can be used, for example, when you forget the ID / password

required to login to the web setting page.

If you can login to the WEB setting page, initialization is possible with "4.2.5.Reset".

The procedure is described below.

VI.
VII.
VIII.

Mount the microSD card to be used to the PC.
Format microSD card in Fat32.
Create a file named "all_reset.bin" just under the drive of the microSD card.
Note: Please make it as a text file and make the file size 0 Byte.
All file names should be in lower case.
Unmount & Remove the microSD card from the PC.
Power off this camera.
Mount the microSD card to this camera.
Power on this camera.
Please wait for a while until it starts up. It will start in about 30 seconds.
When this camera is initialized correctly, "all_reset.bin" of the microSD card will be
deleted. If initialization is not done, remount the microSD card to the PC and confirm
that "all_reset.bin" has been deleted.

If "all_reset.bin" has not been deleted, please check the file name and file size again.
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7. Reference

7.1. How to use ONVIF Device Manager

This camera conforms to the ONVIF Profile S.

Download the ONVIF Device Manager (ODM) from the following link;
http://sourceforge.net/projects/onvifdm/

Then install the ODM to your PC and initiate the ODM.

ODM starts as follows;

—— -

Figure 35. ODM screen
If the network configuration has been successfully connected without error, the

WAT-933_ENTRY or WAT-2400S_ENTRY will show up in the Device list. Please make sure

there is no error in the network settings if you do not see.
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In the text box at the top of the screen, enter the ID and Password of the above-mentioned
the User Information page in Name and Password respectively, and click "Log in".

When you have not changed, enter Name: root, Password: 1234.

Figure 36. ODM Login
Once you have finished the login and click the “WAT-933 _ENTRY” or “WAT-2400S_ENTRY”

of the Device list. Since the menu is open, click "Live video". If there is not any problem, the

moving image will be displayed as shown in the figure below.

Figure 37. Live video screen

In case of such as “Loading” is displayed and the image does not appear, please restart the
ODM.
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7.2. FTP Access
You can access internal storage by using FTP.

This section explains the connection method of using "FileZilla".
7.2.1. Acase of FileZilla

Download the appropriate Installer which meets your PC from FileZilla official download

page (https://filezilla-project.org/) and install it.

Open the FileZilla when the installation is completed.

Figure 38. FileZilla screen
When this camera is the default setting, enter the following in the red line above.
Host: 192.168.1.250
Username: root
Password: 1234

Port: (Blank)

Click "Quickconnect" to access internal storage.
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7.3. When streaming does not play on WEB setting page

Please check the following items.

7.3.1. Checking the web browser you are using

Internet Explorer 11 (simply called the “IE11” from now.) only supports streaming on the web
setting page.

In order to display streaming of the IE 11, please make the following settings.

7.3.2. Setting the IE
. Start the IE11

Il Click “Tools”->"Internet options”->”Advanced”->"Reset”

=]

ik,
Print 3
File »
Zoom (1009%) ’
Safety ’
Add site to Start menu
View downloads Ctri+J

Manage add-ons

F12 Developer Tools

Go to pinned sites
Compatibility View settings

Report website problems
Internet options
About Internet Explorer

Figure 39. How to set the IE 11 (No.1)
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Iv.

V.

VL.

Click “Reset”

Figure 40. How to set the IE 11 (No.2)

Reset Internet Explorer Settings

How does resetting affect my computer?

Are you sure you want to reset all Internet Explorer
settings?

Resetting includes:

+ Disable toolbars and add-ons °
+  Default web browser settings .
* Privacy settings

+  Security settings

Advanced options
Tabbed browsing settings
Pop-up settings

[ Delete personal settings

Resets home pages, search providers and Accelerators to default settings.

Deletes temporary Internet files, history, cookies, web form information,

ActiveX Filtering data, Tracking Protection data, Do Not Track data, and
passwords.

You must restart your computer for these changes to take effect.

e

[ Reset ] I Cancel

|

Restart the IE11

Figure 41. How to set the IE 11 (No.3)

Click “Tools”->"Internet options”->"Security”

Select “Internet”->"Medium”
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VII. Click “OK”

Figure 42. How to set the IE 11 (No.4)

VIIl. Uncheck “Tools”->"Safety”->“ActiveX Filtering”

Print

File

Zoom (100%)
Safety

Add site to Start menu
View downloads

Manage add-ons

F12 Developer Tools

Go to pinned sites
Compatibility View settings

Report website problems
Internet options
About Internet Explorer

Ctrl+]

Delete browsing history...
InPrivate Browsing
Turn on Tracking Protection

Turnon Do bhlot Track roquaocte
T

ActiveX Filtering

Webpage privacy policy...

Check this website
Turn off SmartScreen Filter...
Report unsafe website

Ctrl+Shift+Del
Ctri+Shift+pP

I

Figure 43. How to set the IE 11 (No.5)

IX. Restart the IE11, Access the setting page
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7.3.3. Reinstall the VLC
Note: If the streaming was not successful with “2. Setting the IE”, please follow the

procedure in “3. Reinstall the VLC".

. Uninstall the VLC
When the 64bit OS, uninstall the VLC for 32bit and 64bit

II. Install the VLC
When the 32bit OS, install the VLC for only 32bit.
When the 64bit OS, install the VLC for 32bit and 64bit.

32bit VLC: https://get.videolan.org/vlc/3.0.3/win32/vic-3.0.3-win32.exe
64bit VLC: https://get.videolan.org/vlc/3.0.3/win64/vic-3.0.3-win64.exe

When the following window is displayed halfway, select "Full" or check "ActiveX plugin".

= VLC media player Setup .

Choose Components

£

A
Choose which features of VLC media player you want to install. ;_l‘

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select the type of install: Full -
Or, select the optional . Media Player (required) A~
components you wish to 4] Start Menu Shortcut

install: Desktop Shortcut

=¥ Web plugins
Mozill i

i[¥] Discs Plavback
Description

Space required: 158.5 MB

| <Bak | Net> | [ cancel

Figure 44. Installation of the VLC

lll. Restart the IE11, Access the setting page
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https://get.videolan.org/vlc/3.0.3/win32/vlc-3.0.3-win32.exe
https://get.videolan.org/vlc/3.0.3/win64/vlc-3.0.3-win64.exe

7.3.4. Disable Anti-Virus
Note: If streaming was not successful with “3. Reinstall the VLC”, please follow the

procedure in “4. Disable Anti-Virus”.

Please note that Watec is not responsible for any damage or loss caused through disable
Anti-virus.

l. Disable Anti-Virus

ll. Restart the IE11, Access the setting page
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